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Preface

Oracle IRM Desktop is a small application that must be installed on every computer 
that will be used to seal documents using the Oracle IRM encryption technology. 
Oracle IRM Desktop must also be installed to read documents that have been sealed 
using this technology. Oracle IRM Desktop is the client software for Oracle IRM Server, 
which is installed and maintained centrally by organizations wanting to produce 
sealed documents. The Oracle IRM Desktop client must have access to the Oracle IRM 
Server installation so that the rights of users to read sealed documents can be 
ascertained. Access to Oracle IRM Server must be regular, but need not be continuous: 
Oracle IRM Desktop caches user rights locally and will allow access to sealed 
documents for a pre-determined period, usually a few days, before access to Oracle 
IRM Server is required. 

This user guide contains procedures for using the Oracle IRM Desktop client product. 
This guide also contains descriptions of the user interface for the product. 

Audience
This document is intended for end users of Oracle IRM Desktop. 

Documentation Accessibility
Our goal is to make Oracle products, services, and supporting documentation 
accessible to all users, including users that are disabled. To that end, our 
documentation includes features that make information available to users of assistive 
technology. This documentation is available in HTML format, and contains markup to 
facilitate access by the disabled community. Accessibility standards will continue to 
evolve over time, and Oracle is actively engaged with other market-leading 
technology vendors to address technical obstacles so that our documentation can be 
accessible to all of our customers. For more information, visit the Oracle Accessibility 
Program Web site at http://www.oracle.com/accessibility/.

Accessibility of Code Examples in Documentation
Screen readers may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an 
otherwise empty line; however, some screen readers may not always read a line of text 
that consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation
This documentation may contain links to Web sites of other companies or 
organizations that Oracle does not own or control. Oracle neither evaluates nor makes 
any representations regarding the accessibility of these Web sites.

TTY Access to Oracle Support Services
To reach AT&T Customer Assistants, dial 711 or 1.800.855.2880. An AT&T Customer 
Assistant will relay information between the customer and Oracle Support Services at 
1.800.223.1711. Complete instructions for using the AT&T relay services are available at 
http://www.consumer.att.com/relay/tty/standard2.html. After the 
AT&T Customer Assistant contacts Oracle Support Services, an Oracle Support 
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Services engineer will handle technical issues and provide customer support according 
to the Oracle service request process.

Related Documents
For more information, see the Oracle IRM Desktop Installation Guide, the Oracle IRM 
External User Support Guide, the Oracle IRM Quick Start Guide, and the Oracle IRM 
Server Administrator’s Guide.

Conventions
The following text conventions are used in this document:

The following conventions are used throughout this guide:

■ The notation <Install_Dir> is used to refer to the location on your system where 
Oracle IRM Server is installed.

■ Forward slashes (/) are used to separate the directory levels in a path name. A 
forward slash will always appear after the end of a directory name.

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated 
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for 
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code 
in examples, text that appears on the screen, or text that you enter.
x                                                                 



About Sealed Documents
1About Oracle IRM and Sealed Content

This section covers the following topics:

■ "About Oracle IRM" on page 1-1

■ "About Sealed Documents" on page 1-1

■ "About Rights" on page 1-2

■ "About Contexts" on page 1-5

■ "About Connecting to Oracle IRM Server" on page 1-6

■ "About Synchronizing with Oracle IRM Server" on page 1-6

■ "About Sealed Document Item Codes" on page 1-6

■ "About Microsoft Office Templates" on page 1-8

■ "About Sealed Multimedia Files" on page 1-8

■ "About Oracle IRM Fields and Watermarks in Sealed Documents" on page 1-8

1.1 About Oracle IRM
Oracle Information Rights Management (Oracle IRM, formerly SealedMedia E-DRM) 
is an information security solution that uses encryption to 'seal' content (documents 
and emails). Access to the decryption keys is carefully controlled, so that only 
authorized end users can open and use the sealed content, regardless of where it is 
stored and used.

Oracle IRM enables authorized users to create and use sealed content transparently 
within existing desktop applications, such as Microsoft Office, Adobe Reader and 
Lotus Notes, without requiring detailed knowledge of keys or passwords. A one-time 
installation of the Oracle IRM client software, Oracle IRM Desktop, supports current 
and previous versions of these standard desktop applications, and continues to protect 
and track sealed documents and emails while they are in use within them.

Oracle IRM also continues to protect and track sealed content when it is stored and 
used on desktops beyond the firewall of the originating organization. Recipients of 
sealed documents and emails may be authorized by the originating organization to 
use them in one or more different ways, including reading them, replying to them, 
editing them, searching them, copying them, and printing them. 

When the originator of a sealed document or email decides that the content is no 
longer valid, or when the originator decides to change who can use a sealed document 
or email, the rights can be revoked and the recipient may find that they can no longer 
read it.

1.2 About Sealed Documents
Sealed documents are encrypted files that are accessible only to authorized users. They 
have distinctive icons and file extensions. See "Formats" on page 8-6 for a full list.
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About Rights
The Oracle IRM solution supports a wide range of document formats, including 
Microsoft Word, Excel, and PowerPoint, PDF, HTML, RTF and text, and various image 
and movie formats. 

Supporting popular document formats enables the Oracle IRM solution to fit 
seamlessly into existing working practices, ensuring the security and confidentiality of 
critical business information.

Your ability to work with a particular sealed document depends on the rights defined 
for you in the contexts to which the document is sealed. For example, your rights to 
work with documents in a Top Secret context and a Confidential context might be very 
different.

1.3 About Rights
Rights control what you can and cannot do with sealed documents. 

Your rights to a particular sealed document can range from none (so you cannot even 
open the document), to Open (so you can read it on your computer screen, but do 
nothing else with it), through a range of rights to, for example, edit, print, and search 
the document. Your rights also control your ability to create new sealed documents.

Your rights can be changed over time, can differ from the rights of other users, and can 
differ from one sealed document to another. Your rights to a particular document 
depend on what context that document is sealed to. For example, your rights to 
documents in a Top Secret context might be much more restricted than for documents 
in a Confidential context. 

Some rights effectively include others (for example, if you have the Edit right, you 
effectively get the Annotate and Interact rights), and some rights require others (for 
example, if you have the Edit right, you need the Open right to access the document, 
and you need the Reseal right so that you can save your edits). 

When you are viewing a particular sealed document, you can see your rights for that 
document on the Rights tab of the Oracle IRM Desktop Control Panel. The Rights tab  
lists only rights that are relevant to the type of sealed document you are viewing. 

This guide tells you the rights you need to perform common Oracle IRM tasks. If you 
need to perform tasks for which you do not have rights, you should ask an Oracle IRM 
Server administrator whether you can be given the necessary rights. 

The complete set of rights is described in Table 1–1, " Rights".

Note to Oracle IRM Server administrators: The "rights" available in 
Oracle IRM Desktop are created by assigning "features" and setting 
constraints within Oracle IRM Server. See the Oracle IRM Server 
Administrator’s Guide for full details. 
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About Rights
Table 1–1 Rights

Right Description Usage notes

Accessibility Relaxes protection of sealed files so 
the use of accessibility tools and 
features is not blocked for sealed files. 
It does this by turning off program 
protection, screen capture protection, 
and keyboard protection in the file. 

Some accessibility tools might work 
even without this right.

Annotate Allows you to add comments in 
Microsoft Excel and Microsoft Word 
documents (DOC and RTF formats). 

The ability to add comments may be 
the only editing you can do on sealed 
documents. 

In Microsoft Word, the Annotate right 
negates the Interact right. 

Copy Allows you unrestricted use of the 
clipboard while working on a sealed 
document. 

Applicable only to Microsoft Office, 
email, and PDF. 

Use of the clipboard within a 
particular sealed document does not 
require any rights other than the Edit 
right. 

Copy To Allows you controlled use of the 
clipboard while working on sealed 
documents. 

Allows you to copy information 
between documents that are sealed to 
the same context. 

Allows you to copy information 
between documents in different 
contexts. 

Allows you to change the context that 
a document is sealed to. 

Allows you to make a copy of a 
document in a different context. 

Use of the clipboard within a 
particular sealed document does not 
require any rights other than the Edit 
right. 

Even with this right, you may 
sometimes not be able to use the 
clipboard (for example, in some 
multi-process environments). 

If you have rights to copy to other 
contexts, you also need the relevant 
rights in those contexts. For example, 
to copy to a document in another 
context, you need the right to open 
and edit documents in that context. 

To change the context that a document 
is sealed to, you need the Copy To 
right for the current context and the 
Seal right for the destination context. 

Edit Allows you to edit Microsoft Office 
documents. 

The Edit right includes the Edit 
Tracked, Annotate, Interact, and 
Formulae rights. 

Edit Tracked Allows you to edit Microsoft Office 
documents, but enforces the use of 
the track changes feature of Microsoft 
Word. 

The Edit right includes the Annotate, 
Interact, and Formulae rights. 

Formulae Allows you to select and view 
formulae (formulas) in Microsoft 
Excel workbooks.

The Formulae right is included in the 
Edit and Edit Tracked rights. 

Interact Allows you to enter data into Form 
fields in Microsoft Word documents. 

Allows you to enter data into 
unprotected cells of Microsoft Excel 
documents. 

The Interact right is included in the 
Edit and Edit Tracked rights.

In Microsoft Word, the Interact right is 
ineffective if the Annotate right has 
also been granted. 
                                     About Oracle IRM and Sealed Content 1-3



About Rights
Open Allows you to open a sealed 
document and view it on screen. 

The Open right might be the only right 
you have to a document. 

The Open right is a prerequisite for all 
other rights except Seal and Search. 

Print Allows you to print documents to 
create paper copies.

The Print right is included in the Print 
to File right. 

Print To File Allows you save a document as a 
print file, or send documents to a 
virtual printer (for example, Acrobat). 

Print To File includes the Print right.

Program Allows you to use macros within a 
sealed document to manipulate the 
document's content.

Reply Allows you to edit a sealed email to 
create a reply. 

You also need Reseal to save your 
email edits. 

You do not need Edit when replying to 
sealed email.

Reply does not allow you to create 
new sealed emails. That requires the 
Seal right. 

Reply Tracked Allows you to edit a sealed email to 
create a reply, but enforces the track 
changes feature.

You also need the Reseal right to save 
your email edits.

Reply Tracked does not allow you to 
create new sealed emails. That 
involves creating a new sealed 
document, and therefore requires the 
Seal right.

Reseal Allows you to save edits to a sealed 
document or to a sealed email reply. 

When you save a sealed document, 
you can use a different filename, but 
the new file is subject to exactly the 
same licensing as its source document.

The Reseal right is not associated with 
the Reseal To option available when 
right-clicking a sealed file in Windows 
Explorer. For an explanation of the 
Reseal To option, see the Copy To 
right. 

Save Unsealed Allows you to create an unsealed 
copy of a sealed document. 

This right enables you to create an 
unprotected copy of a sealed 
document, so it is usually given only 
for relatively non-sensitive 
documents. 

An unsealed document can be created 
using the Save As option in 
applications. 

An unsealed document can also be 
created using the Unseal option when 
you right-click a sealed file in 
Windows Explorer. 

Table 1–1 (Cont.) Rights

Right Description Usage notes
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About Contexts
1.4 About Contexts
A context is a type or grouping of sealed content. For example, you might have 
contexts for secret sales matters, confidential sales matters, proprietary research 
matters, confidential partner communications, and so on. 

The rights defined for each context can be very different so, for example, you might 
have rights to open, edit, and print confidential sales documents, but only the right to 
open secret sales documents, and no rights at all for research documents. Different 
users have different rights in different contexts. 

If you are the owner or creator of sensitive documents, you can work with the 
licensing administrator (or, in Oracle IRM terms, the "domain manager") to create one 
or more contexts to protect that information. For example, if you are developing a new 
product, you might create contexts to protect the requirements, specifications, designs, 
market projections, competitive information, legal information, patents, and so on. 
Your domain manager can help you decide whether you need new contexts, or 
whether existing contexts are suitable for your information. 

Screen 
Capture

Allows you to take screen captures of 
sealed documents. (See "Screen 
Capturing Sealed Documents" on 
page 4-9.)

Apart from its obvious use, you might 
be given this right if you have a 
legitimate reason to use an application 
that sends images from your computer 
to another computer, such as a web 
presentation product.

Seal Allows you to create a new sealed 
document or email. 

Typically, if you have the Seal right, 
you also have the Edit right, so that 
you can edit the documents you 
create. However, if you have been 
given the Seal right so that you can 
use sealed email, it is possible that you 
will not have the Edit right. Sealed 
email usage requires the Seal right for 
email creation, and the Reseal and 
Reply (or Reply Tracked) rights for 
replying. 

Search Allows you to use Microsoft 
Windows search facilities to search 
the content of sealed documents. 

Unless you have this right, searches 
will not include the content of sealed 
documents. 

Searching sealed PDF requires a search 
filter from Adobe as well as the Search 
right.

Set Item Code Allows you to manually set the item 
code of a sealed document. 

Item codes are mostly allocated and 
updated automatically, and reflect the 
name of a sealed document and the 
time that it was sealed. Not all sealed 
documents have item codes. 

You might be given the right to 
allocate item codes manually. If so, 
you will see some extra options and 
messages when working with sealed 
documents, and you should be trained 
to understand what you need to do. 

Table 1–1 (Cont.) Rights

Right Description Usage notes
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About Connecting to Oracle IRM Server
1.5 About Connecting to Oracle IRM Server
Before you can create or read sealed documents, your installation of Oracle IRM 
Desktop must be connected to the license server (Oracle IRM Server) that holds the 
user and context information for the documents to be created or read. 

If you have been sent a sealed document and want to read it, simply opening the 
document will initiate connection to the license server. You may be asked to provide 
login details, after which you will be able to use the sealed document to the extent that 
your rights allow. You will find that the server to which you have been connected is 
listed on the Servers tab of the Oracle IRM Desktop Options dialog. 

If you wish to seal a document to a context hosted by a license server that is not yet 
listed on the Servers tab, you will need to connect to that server manually.  See 
"Connecting to Oracle IRM Server Manually" on page 7-2.

1.6 About Synchronizing with Oracle IRM Server
For the license servers to which you are connected, your local cache of rights is 
updated by synchronizing to connected license servers (Oracle IRM Server). This 
allows you to keep working with sealed documents even when you are disconnected 
from the network and cannot contact the license server. Typically, your cached rights 
allow you to keep using documents for several days before being required to contact 
the license server.

Synchronization is almost completely automatic. Typically, it runs daily during 
standard office hours, but the schedule is controlled by the administrator of the license 
server.

If synchronization fails for any reason, the application displays a failure message and 
automatically retries at intervals.

If you log in manually to access sealed documents (because, for example, you did not 
opt to save your credentials at the initial login dialog), then you will need to initiate 
synchronization manually. 

You can initiate synchronization manually at other times: for example, if someone 
notifies you that your rights have changed, and you want to synchronize immediately 
rather than wait for the automatic process. See "Synchronizing Your Rights Manually" 
on page 7-2.

1.7 About Sealed Document Item Codes
For most users, it is not necessary to understand what item codes are. In the vast 
majority of cases, item codes are managed automatically. Only a minority of users are 
likely to be given manual control over item codes, and they are likely to exercise that 
control very rarely. 

However, for some tasks it is useful to understand what item codes are. 

When you seal a document to a context, such as Secret Sales Matters, the document is 
subject to the licensing defined for that context. By default, all documents in a given 
context are subject to the same licensing. This is advantageous because users very 
quickly learn which sealed documents they can open, print, edit, and so on. 

However, inevitably the need will arise for exceptions to be made for particular 
documents. For example, it might be necessary to allow an auditor access to a 
particular secret merger document, but not to all secret merger documents. 
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About Sealed Email
To support such exceptions, every sealed document has an item code. For example, the 
auditor might be given the right to open Q3-sales-receipts.sxls, but none of the other 
secret sales documents. 

Item codes usually reflect a sealed document's file name and creation date, but not 
necessarily. 

For example, the illustration shows a sealed document called merger-proposal.sdoc 
that has an item code of 2009_06_10 14:10:49 merger.sdoc. 

In this case, it appears that merger-proposal.sdoc is a renamed copy of a sealed 
document called merger.sdoc. Renaming a sealed document does not change the item 
code, so the copy is subject to exactly the same licensing as the original. 

In most cases, such a document's item code will be updated automatically the next 
time an authorized user changes its content. Even then, it will almost always be subject 
to the same licensing because it is sealed to the same context as the original, but the 
change of item code provides the option for the original document and the modified 
copy to be licensed independently of each other. 

In rare cases, some users might be authorized to allocate item codes manually. This, for 
example, enables a user to create several documents that have the same item code 
regardless of their file names, such that the documents can be handled as a unit for 
licensing purposes. However, in the vast majority of cases, the allocation and update of 
item codes is automatic. 

1.8 About Sealed Email
In any business environment, confidential and sensitive information is entrusted to 
email communications. The Oracle IRM solution therefore provides the tools you need 
to enable you to seal email just as you seal other types of content.

To work effectively with sealed email, you need to:

■ Create and send sealed email.

■ Open sealed email that you receive.

■ Create and send sealed replies.

■ Forward sealed emails.

Oracle IRM Desktop enables all of the above so that you can participate in sealed email 
threads. See "Using Sealed Email" on page 5-1.

Your rights to create and reply to sealed email are managed separately from your 
rights to create and edit other types of sealed document. For example, you might find 
that you can create sealed email in a context in which you do not have the right to 
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About Microsoft Office Templates
create a new sealed Word document, or you might find that you can reply to sealed 
email, but not create new sealed email.

1.9 About Microsoft Office Templates
The Oracle IRM solution supports two ways of using templates to enable 
organizations to create sealed documents consistently: 

■ You can use sealed Microsoft Office templates to create Microsoft Word, Excel, and 
PowerPoint documents consistently.

■ You can create sealed documents from regular Microsoft Office templates.

See "About Using Sealed Microsoft Office Templates" on page 4-12.

In each case, your templates can contain Oracle IRM fields that help to remind users of 
the sensitive nature of the documents created from them. For example, a template 
might have headers and footers that contain fields that identify the context of the 
documents, and the name of the user who opens a particular copy.

1.10 About Sealed Multimedia Files
Oracle IRM supports a range of video file formats, and a set of rights that are specific 
to playing video files. See "About Rights" on page 1-2. 

You can seal video files in the same way as you seal other types of file. For example, 
users of the Oracle IRM Desktop can select video files in Windows Explorer and select 
Seal To from the File menu. You are prompted to select a context for the files.

When you open sealed video files, the Oracle IRM Desktop toolbar provides buttons 
for playing, pausing, and stopping the file. 

You will need to have QuickTime Player installed on your PC to be able to play back 
sealed video files.

1.11 About Oracle IRM Fields and Watermarks in Sealed Documents
If you are an author of sealed documents, you can add Oracle IRM fields to your 
document sources before sealing. When someone opens a sealed document that 
contains Oracle IRM fields, the fields help to remind the reader that the document is 
sensitive. Oracle IRM fields used as watermarks can help to make a printed copy of 
the document traceable in the event that it falls into the wrong hands. 

You can use Oracle IRM fields in Microsoft Word and Microsoft Excel. See "Working 
With Oracle IRM Fields and Watermarks" on page 6-1. 

For these applications, you can also create templates that contain a set of Oracle IRM 
fields, and apply them consistently to new documents. For example: 

■ For Microsoft Word, you can create a sealed Word template that contains the fields 
in headers and footers, and use that template to create a new sealed document.

■ For PDF, you can create a PDF file that contains the fields, and then use it as a 
watermark file for other PDF files.

When viewing the unsealed source, the fields appear as field names or placeholder 
strings. However, when sealed and viewed with Oracle IRM Desktop available, the 
fields are transformed to contain the relevant data. For example, irm-account-name 
might be transformed to John.Smith, the name of the user who opens a particular copy 
of a sealed document.
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2Installing Oracle IRM Desktop on Client
Computers

Oracle IRM Desktop can be installed by anyone intending to use the product to read 
documents that have been sealed using Oracle IRM encryption technology, or to seal 
documents. The person installing the product must have administrator rights for the 
computer on which it is being installed. Many organizations do not give administrator 
rights to individual users, in which case the organization’s IT specialists should install 
the product. 

This section explains the process of installing Oracle IRM Desktop on client 
computers. It covers these topics: 

■ "System Requirements" on page 2-1

■ "Installing Oracle IRM Desktop" on page 2-2

■ "Uninstalling Oracle IRM Desktop" on page 2-3

■ "Upgrading Oracle IRM Desktop" on page 2-2

■ "Silent and Unattended Installations" on page 2-3

■ "Interoperability Notes" on page 2-8

2.1 System Requirements
■ 486 or Pentium PC-compatible computer

■ 25 MB free disk space

■ Microsoft Internet Explorer 6.0 or later

Supported Operating Systems
■ Microsoft Windows 2000 Professional

■ Microsoft Windows XP

■ Microsoft Windows Vista

■ Microsoft Windows 7

■ Microsoft Windows Server 2003

■ Microsoft Windows Server 2008

The latest operating system service packs are recommended.

Supported Browsers
Oracle IRM Desktop operates as a plug-in to the following browser versions:

■ Microsoft Internet Explorer 6.0 or later

Note: Do not install on Exchange Server systems, because Oracle 
IRM Desktop and Exchange Server have conflicting uses for the .stm 
file extension that can impact the operation of mail services.
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Oracle IRM recommends using Internet Explorer 7.0 or later. Note that Internet 
Explorer does not need to be your default browser, it just needs to be available on the 
system.

Installation Privileges
The installation requires administrator privileges or elevated privileges.

2.2 Installing Oracle IRM Desktop

Oracle IRM Desktop is typically downloaded and installed from a web page. The web 
page might be hosted by Oracle IRM, or by another organization. Typically, you will 
be told the address of the download site. 

1. Close all instances of Microsoft Word, PowerPoint, Excel, and Outlook.

2. Uninstall any previous version of Oracle IRM Desktop or the SealedMedia 
Unsealer or Desktop software.

3. Go to the Oracle IRM Desktop download site.

4. Follow any instructions on the Oracle IRM Desktop download site for 
downloading the installation file.

5. Run the downloaded installation file and follow the installation wizard. 

Do not attempt to install Oracle IRM Desktop on a mapped drive or on a drive defined 
using the subst command.

Silent and unattended installations are also supported (see "Silent and Unattended 
Installations" on page 2-3).

2.3 Upgrading Oracle IRM Desktop
You can upgrade to this version of Oracle IRM Desktop from version 5.5 onwards, by 
running the installation wizard on the computer that has the older version.

For versions earlier than 5.5, or from any version of SealedMedia Unsealer or Desktop, 
you can upgrade to this version only by uninstalling the older version and installing 
this one.

Note: If you are reading this section in the online help, then Oracle 
IRM Desktop is already installed. 

Caution: When upgrading from an earlier version of Oracle IRM 
Desktop, you will lose the rights to use sealed documents that are 
stored locally (the rights that enable you to continue working when 
you are offline). When this happens, you will have to obtain new 
rights by going online and synchronizing with the server. For this 
reason, do not begin an upgrade unless you have online access to the 
server. 
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2.4 Uninstalling Oracle IRM Desktop

To uninstall Oracle IRM Desktop from a computer, you need administrator rights for 
that computer. 

Use the Control Panel Add/Remove Programs dialog to uninstall Oracle IRM 
Desktop, if required. Alternatively, run the installer and you will be offered the option 
to uninstall.

Uninstalling Oracle IRM Desktop does not delete your local rights database from your 
system. If you re-install, your existing rights will still be available. 

2.5 Silent and Unattended Installations
Silent and unattended installations are intended to be made by IT specialists with full 
administrator rights for all the client computers. 

This section contains the following topics:

■ "About Silent and Unattended Installations" on page 2-3

■ "Authentication Settings" on page 2-4

■ "Oracle IRM Desktop Settings" on page 2-4

■ "Desktop Sealing Settings" on page 2-5

■ "Synchronization Manager Settings" on page 2-6

■ "Search Settings" on page 2-7

■ "Email Settings" on page 2-7

■ "Legacy Setting" on page 2-8

■ "Extracting the MSI File from the Self-Extracting Executable" on page 2-8

2.5.1 About Silent and Unattended Installations
The Oracle IRM Desktop installation package is a self-extracting executable that 
contains an MSI installer. If you are the network administrator for many Oracle IRM 
Desktop users, you can use the installer to manage silent installations and 
preconfigure settings. 

You can either pass arguments to the self-extracting executable, or run it once to 
extract the MSI installer and then use msiexec.exe to pass arguments directly to it.  
However, if using GPO then the standard way to set parameters is to use Orca from 
the Windows SDK to create MST files that set the required arguments, then to apply 
that transform and the MSI together in GPO.

The following example shows how to pass arguments directly to an extracted MSI 
installer:

■ msiexec /i "OracleIRMDesktop_en.msi" /qn EMAIL_OUTLOOK_ACTIVATED=1

The following shows how to achieve the same effect by passing arguments to the 
self-extracting executable:

■ "OracleIRMDesktop_en.exe" /v /qn EMAIL_OUTLOOK_ACTIVATED=1

Caution: If you uninstall Oracle IRM Desktop from a computer, you 
will not be able to use the computer to read sealed documents. 
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The /v argument signifies that other arguments are to be passed to the MSI installer 
within the executable.

The list of configurable settings relate to the functional subcomponents of Oracle IRM 
Desktop:

■ Oracle IRM Desktop - controls access to sealed documents

■ Desktop sealing - integrates sealing options into Windows Explorer

■ Synchronization manager - automates rights synchronization

■ Search integration - integrates with search facilities

■ Email integration - integrates with popular email applications such as Microsoft 
Outlook

The following sections provide information about the configurable settings for each 
subcomponent. All components have valid defaults that enable a user to open and 
work with sealed documents, subject to their rights, immediately after installation. 
Configuration of settings during installation is optional.

After installation, most of the settings are accessible by right-clicking the  Oracle IRM 
icon in the Windows tooltray and selecting Options. For further information about 
particular settings, see the Oracle IRM Desktop help.

2.5.2 Authentication Settings
The authentication settings that you can preconfigure are as follows:

2.5.3 Oracle IRM Desktop Settings
The Oracle IRM Desktop settings that you can preconfigure are as follows:

Property and description UI Option Values Default

AUTHENTICATION_DISABLESAVECREDENTIALS

Determines whether users can cache their 
authentication credentials. If caching is not allowed, 
users will have to enter their username and password 
whenever foreground synchronization to the Oracle 
IRM Server is required. 

None 0 = allow 
caching 
option

1 = disable 
caching 
option

0

AUTHENTICATION_
SUPPRESSPRIVACYPOLICYDIALOG

Suppresses the dialog that allows users to read a 
server's policy on handling personal data. Normally, 
this dialog appears before first contact with any new 
server, and a user must accept the policy before using 
Oracle IRM. This dialog should only be suppressed at 
sites which have a known, fixed list of Oracle IRM 
Servers, and where the users have been informed of 
the privacy policy by other means.

None 0 = show 
dialog 
normally

1 = never 
show 
dialog

0

Property and description UI Option Values Default

UNSEALER_OFFICEENABLED

Determines whether the integration with Microsoft 
Office is enabled.

Enable Microsoft 
Office support

0 = 
disabled

1 = 
enabled

1

4                                                                 



These options relate to settings that appear on the Oracle IRM Desktop tab of the 
Oracle IRM Desktop Options dialog.

2.5.4 Desktop Sealing Settings
The Desktop sealing settings that you can preconfigure are as follows:

These settings relate to options on the Desktop Sealing tab of the Oracle IRM Desktop 
Options dialog.

UNSEALER_SHOWTRAYICON

Determines whether the Oracle IRM icon is shown 
in the system tray.

Display in system 
tray

0 = hide

1= show

1

UNSEALER_SHOWIRMBAR

Determines whether the Oracle IRM information 
bar is displayed within Microsoft Office for sealed 
documents.

Display Sealed 
Office information 
bar

0 = hide

1 = show

1

UNSEALER_HIDEIETOOLBARS

Determines whether the Oracle IRM toolbars are 
displayed when viewing sealed content (specifically 
PDF) within the Internet Explorer browser. 

Hide Internet 
Explorer toolbars for 
sealed PDF

0 = show

1 = hide

1

Property and description UI option Values Default

DESKTOPSEALER_ACTIVATED

Determines whether the sealing of content 
through Oracle IRM Desktop is enabled.

Enable Desktop 
Sealing

0 = disabled

1 = enabled

1

DESKTOPSEALER_
CLASSIFICATIONMRUSIZE

Sets the maximum number of recently used 
contexts displayed in Seal To menus in 
Windows Explorer.

Recently Used 
Context List

integer 5

DESKTOPSEALER_DELETESOURCEFILES

Determines whether the original unsealed 
files are deleted after sealed versions of 
them are created, or whether the original 
unsealed files are moved to the recycle bin, 
and whether the user is prompted before 
these actions.

Delete original file(s) 
after sealing

0 = No deletion

1 = Original files 
moved to 
recycle bin, with 
confirmation

2 = Original files 
permanently 
deleted, with 
confirmation

3 = Original files 
moved to 
recycle bin, with 
no confirmation

4 = Original files 
permanently 
deleted, with no 
confirmation

0

Property and description UI Option Values Default
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2.5.5 Synchronization Manager Settings
The synchronization manager settings that you can preconfigure are as follows. 

These settings relate to the server list on the Synchronization tab of the Oracle IRM 
Desktop Options dialog.

Property and description Values Default

SYNCINITIALSERVERS

Determines a set of servers 
to which Oracle IRM 
Desktop will be initially 
synchronized, as shown in 
the list of synchronized 
servers. The set of servers 
has to be encoded into a 
compound string in the 
form:

<url1>|<value1>[,<url2>|<
value2>,<url3>|<value3>,...
]

For example, to add the following servers:

■ irm1.example.com

■ irm2.example.com

■ irm3.example.com

the string to pass in the SYNCINITIALSERVERS 
property is:

SYNCINITIALSERVERS="https://irm1.example.com/i
rm_desktop|1,https://irm2.example.com/irm_
desktop|1,https://irm3.example.com/irm_desktop|0"

where the value 1 means that synchronization for the 
server is enabled and the value 0 means that 
synchronization for the server is disabled.

None

SYNCLOCKEDSERVERS

Determines a set of servers 
that are locked from user 
modification. If a locked 
server appears in the list of 
synchronized servers, the 
user cannot disable 
synchronization for that 
server, nor remove it from 
the list of synchronized 
servers.

The presence of a server in 
this set does not add it to 
the list of synchronized 
servers. Locked servers will 
appear in the list of 
synchronized servers only 
because they have been 
added through the 
SYNCINITIALSERVERS 
property or because a user 
has added it.

For example, to lock the following servers:

■ irm1.example.com

■ irm2.example.com

the string to pass in the SYNCLOCKEDSERVERS 
property is: 

SYNCLOCKEDSERVERS 
="https://irm1.example.com/irm_
desktop|1,https://irm2.example.com/irm_desktop|1"

where the value 1 means the server is locked. A value 
of 0 would mean that the server is unlocked, but this 
has the same effect as simply not listing the server. 

None

Property and description UI option Values Default

SYNC_LOGLEVEL

Determines the level of logging of 
synchronization messages to the 
Windows event log. The messages 
are categorized as low-level, 
standard, and detailed. 

Synchronization 
Messages

0 = no messages

2 = low-level

4 = detailed

6= detailed and low-level

8 = standard

10 = standard and low-level

12 = standard and detailed

14 = standard and detailed 
and low-level

8
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These settings relate to the checkboxes on the Synchronization Log Configuration 
dialog.

2.5.6 Search Settings
The search settings that you can preconfigure are as follows:

These settings relate to the option on the Search tab of the Oracle IRM Desktop 
Options dialog, and to the checkboxes on the Search Log Configuration dialog.

2.5.7 Email Settings
The email settings that you can preconfigure are as follows: 

Property and description UI option Values Default

SEARCH_ENABLED

Determines whether searching of sealed 
documents is enabled. 

Enable Search 0 = disabled

1 = enabled

[1]

SEARCH_REPORTERRORS

Determines whether search errors are reported 
in the Windows event log. 

Search Error 
Messages

0 = do not 
report

1 = report

1

SEARCH_REPORTWARNINGS

Determines whether search warnings are 
reported in the Windows event log. 

Search Warning 
Messages

0 = do not 
report

1 = report

0

SEARCH_REPORTINFORMATION

Determines whether search information is 
reported in the Windows event log.

Search Information 
Messages

0 = do not 
report

1 = report

0

Property and description UI option Values Default

EMAIL_OUTLOOK_ACTIVATED

Determines whether the sealed email 
integration is activate within Microsoft 
Outlook. 

Microsoft Outlook 0 = deactivated

1 = activated

0

EMAIL_USECUSTOMTEMPLATE

Determines whether a Microsoft Word 
template file should be used when 
sending sealed emails. 

Use Custom Template 0 = do not use 
custom 
template

1 = use custom 
template

0

EMAIL_CUSTOMTEMPLATEFILE

Specifies the Microsoft Word template file 
to use when sending sealed emails. The 
file could contain watermarking that you 
want added to every sealed email you 
send.

Specify the Word 
template file....

path and 
filename

none

EMAIL_BODYFILE

Specifies the RTF or HTML file that 
contains the unsealed body text of sealed 
emails.

Template Body File path and 
filename

none
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These settings relate to options on the Email tab of the Oracle IRM Desktop Options 
dialog, and on the Sealed Email Options dialog you can access by clicking the Settings 
button on the Email tab.

2.5.8 Legacy Setting
The term "Legacy" refers to earlier releases of Oracle IRM Server, specifically 10g. The 
legacy setting that you can preconfigure is as follows: 

This setting relates to the authentication dialog that is shown for legacy servers.

2.5.9 Extracting the MSI File from the Self-Extracting Executable
If you prefer to use the MSI file directly, you can extract it as follows:

1. On a test box, run the Oracle IRM Desktop installation executable, but click Cancel 
on the first installation screen.

Runing the executable extracts the MSI file to a subfolder of the current user's 
temporary area. For example:

C:\Documents and Settings\Fred\local settings\temp\_isNNN 

where NNN is a number. This is a subfolder of the folder defined by the %TEMP% 
environment variable.

2. Navigate to that folder and take a copy of the MSI file.

You can now use the MSI file for your corporate roll-out. 

2.6 Interoperability Notes
Oracle IRM Desktop supports a wide range of popular document formats. For each 
format, Oracle IRM Desktop controls the relevant application to display sealed 

EMAIL_BODYTYPE

Determines the type of the unsealed body 
text of sealed emails. 

Unsealed Email Body 0 = blank

1 = plain text

2 = RTF or 
HTML file

1

EMAIL_BODYTEXT

Specifies the unsealed body text of sealed 
emails. 

Specify Text string none

EMAIL_SEALEDFORMAT

Determines the format that sealed emails 
will be sent as. 

Seal Format 0 = Microsoft 
Word

1 = Rich Text 
Format

2 = Plain Text 

0

Property and description UI option Values Default

LEGACY_SHOWAUTHENTICATIONMENU

Determines whether the drop-down menu for 
authentication types is shown. 

Synchronization 
Messages

0 = do not show

1 = show

1

Property and description UI option Values Default
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documents. The following sections describe application requirements for some 
formats. 

Oracle IRM recommends that you install Oracle IRM Desktop after installing the 
relevant rendering applications. For example, if you want to use sealed Microsoft 
Word documents, install Oracle IRM Desktop after installing the Microsoft Office 
software. This ensures that the sealable file formats are registered with Windows 
before the Oracle IRM Desktop installation. 

Sealed Microsoft Office Files (Word, PowerPoint, Excel)
The following releases of Microsoft Office are supported:

■ Microsoft Office 2000

■ Microsoft Office XP

■ Microsoft Office 2003

■ Microsoft Office 2007

Sealed PDF
The following Adobe software is supported:

■ Adobe Reader version 6.0 or later.

You can install Adobe Reader before or after installing Oracle IRM Desktop.

Oracle IRM Desktop displays a warning if you are using an unsupported version of 
Adobe Reader. 

Sealed Video
Video is supported through QuickTime, as follows:

■ QuickTime 4 or later. 

■ QuickTime 5.02 or later, if you want to view sealed MPEG-1 movies.

■ QuickTime 6 or later, if you want to view sealed MPEG-4 movies.

The latest QuickTime version is recommended.

Note: In Microsoft Office 2000, when you open a sealed Microsoft 
PowerPoint file, auto-save is disabled for all open PowerPoint files, 
whether sealed or unsealed. Within Microsoft Powerpoint, the 
auto-save option remains shown as enabled, if it has been set that way 
by a user.
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Opening sealed documents
3Getting Started with Oracle IRM Desktop

This section describes how to use Oracle IRM Desktop for the following typical tasks:

■ "Opening sealed documents" on page 3-1

■ "Sealing an existing document" on page 3-2

■ "Creating a new blank sealed document" on page 3-3

■ "Enabling Microsoft Office integration" on page 3-4

Microsoft Office integration provides sealing functionality on toolbars within the 
Microsoft Office applications you select. 

For information about other tasks, see the Oracle IRM Desktop online help. The help is 
accessible from the Windows Start menu, or from the Oracle IRM Desktop icon on 
your system tray. 

3.1 Opening sealed documents
With Oracle IRM Desktop installed, you can open a sealed document simply by 
double-clicking it in a document browser (such as Windows Explorer). 

Alternatively, with Microsoft Office integration enabled, you can use the toolbars 
within Microsoft Office applications. 
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Sealing an existing document
The first time you open a sealed document, you might be challenged for the username 
and password of your Oracle IRM Server account, and you might be required to 
change your password. If you are challenged for a password, you might be offered a  
Save my passord option, which you can use to ensure that you are not challenged next 
time. 

Having authenticated, the Oracle IRM software checks to see whether you have the 
right to open the sealed document. Typically, the administrator will make sure you 
have rights for the first document you receive. Once opened, your ability to interact 
with the document is controlled by your rights, and can range from read-only access, 
through the ability to add comments or make tracked changes, to full edit rights. 

If you do not have the right to open the document, you are redirected to a web page 
that explains why not. 

3.2 Sealing an existing document
You can seal an existing document in Windows Explorer as follows. The same 
procedure can seal Microsoft Word, Excel, Powerpoint, PDF, HTML, and various other 
document types.  

1. Right-click on the document in Windows Explorer, select Seal To and then Select 
Context. 

A context selection dialog appears:
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Creating a new blank sealed document
The dialog lists security contexts to which you have the right to seal documents. If 
you think the list is incomplete, you can use the Refresh Contexts button to update 
it. 

2. Select the context that you want to use and click OK. 

A sealed document is created in the same folder as the selected document. 

Alternatively, integrated Microsoft Office support provides sealing options within 
Microsoft Office applications. In each case, the option requires the selection of a 
context as shown above. 

3.3 Creating a new blank sealed document
You can create new blank sealed documents from the Windows Explorer File menu - 
just as you can create new unsealed documents.  

For example, you can create a sealed Microsoft Word document, as follows: 

1. In Windows Explorer, select the folder in which you want to create the new sealed 
document. 

2. Select the File menu, then select New, then select Sealed Word Document. 
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Enabling Microsoft Office integration
The context selection dialog appears.  

3. Select a context for the new sealed Word document and click OK.  

4. Use the Save As dialog to name the new document. 

The new document is opened immediately for you to start working with. 

Alternatively, Microsoft Office integration provides toolbars for creating new sealed 
documents within the Microsoft Office applications. 

3.4 Enabling Microsoft Office integration
If Microsoft Office integration is enabled, Oracle IRM Desktop supports the creation 
and editing of sealed Microsoft Office documents, and controls Microsoft Office to 
ensure that you do not accidentally exceed your rights. Microsoft Office integration 
might be enabled automatically. If not, you can enable it manually as follows. 

1. From the Windows Start menu, select Programs, then Oracle IRM Desktop, then 
Options. 

This opens the Oracle IRM Desktop Options dialog. 

Alternatively, you can right-click the Oracle IRM icon in the Windows system tray 
and select Options. 

2. Select the General tab. 

3. If the Enable Microsoft Office support box is not already checked, check it, then 
click OK. 

The next time you start a Microsoft Office application, it will show sealing-related 
options in an Oracle IRM toolbar.  For example, you can use the Save As Sealed button 
on the Oracle IRM toolbar to seal a document:  
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Similar integrations for email applications are provided on the Email tab of the Oracle 
IRM Options dialog. 
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4Working with Sealed Documents

This section covers the following topics:

■ "Opening Sealed Documents" on page 4-1

■ "Editing Sealed Documents" on page 4-2

■ "Creating New Sealed Documents" on page 4-3

■ "Saving Changes to Sealed Documents" on page 4-5

■ "Changing the Contexts that Documents are Sealed to" on page 4-6

■ "Unsealing Sealed Documents" on page 4-7

■ "Searching Sealed Documents" on page 4-7

■ "Printing Sealed Documents" on page 4-9

■ "Screen Capturing Sealed Documents" on page 4-9

■ "Sharepoint Behavior" on page 4-10

■ "Using Sealed Microsoft Excel Spreadsheets" on page 4-10

■ "Using Sealed Microsoft Office templates" on page 4-12

4.1 Opening Sealed Documents
This section covers the following topics:

■ "About Opening Sealed Documents" on page 4-1

■ "Opening a Sealed Document in Windows Explorer" on page 4-1

■ "Opening a Sealed Document in a Microsoft Office Application" on page 4-2

4.1.1 About Opening Sealed Documents
Your rights (see "About Rights" on page 1-2) determine whether you can open a sealed 
document, and what you are allowed to do with the document once it is open. 

To open a document that has been sealed using Oracle IRM, you must have Oracle 
IRM Desktop installed on your computer. 

4.1.2 Opening a Sealed Document in Windows Explorer

Use one of the following procedures to open a document in Windows Explorer:

■ Double-click the document name.

■ Select the document name, then select Open from the File menu.

Rights: To open a sealed document, you need the Open right. See 
"About Rights" on page 1-2. 
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4.1.3 Opening a Sealed Document in a Microsoft Office Application

If you have enabled Microsoft Office support (see "General Tab" on page A-1), you can 
use the Oracle IRM Desktop toolbar to open a sealed document.

Use the following procedure to open a sealed document in a Microsoft Office 
application:

1. Open the Microsoft Office application.

2. On the Oracle IRM Desktop toolbar, click the Open Sealed button.

This opens the Open Sealed dialog, which lists sealed documents of the type 
shown in the Files Of Type drop-down list.

3. In the Files Of Type drop-down list, select the type of sealed file to open (for 
example, Sealed Word Document).

4. In the files area, select the sealed file to open.

5. Click Open.

You can also open sealed documents in the same way as other documents. For 
example, you can click the Open button in the Microsoft Word toolbar, and then select 
a sealed document from the familiar Open dialog. In this case, you can use the All 
Files option in the Files Of Type drop-down list to show any type of file, whether 
sealed or not.

4.2 Editing Sealed Documents
This section covers the following topics:

■ "About Editing Sealed Documents" on page 4-2

■ "About Using the Clipboard while Editing Sealed Documents" on page 4-3

4.2.1 About Editing Sealed Documents
If you have sufficient rights, as explained below, you can make changes (edit) sealed 
documents in the same way and for the same reasons that you would make changes to 
unsealed documents. 

As a prerequisite to editing a sealed document, you need the Open right. See "About 
Rights" on page 1-2. You will also need at least one edit right, as described below. 

If you have been given the Edit right, you are able to edit a document as you would an 
unsealed document (unless other rights have been applied that restrict this). You may 
find that some application features have been restricted to increase document security. 

If you have been given the Edit Tracked right, you are able to edit a document, but the 
track changes option is automatically invoked. 

If you have been given the Interact right, you are able to fill in form fields. If this is the 
only edit right you have been given, other types of edit are prevented. 

If you have been given the Screen Capture right, you are able to take screen captures. 

Rights: To open a sealed document, you need the Open right. See 
"About Rights" on page 1-2.
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If you have been given the Program right, you are able to use macros that process or 
modify sealed content. 

4.2.2 About Using the Clipboard while Editing Sealed Documents
If you have sufficient rights, as explained below, you can use the clipboard to move 
content from one document to another. 

If you have been given the Edit right, you can use the clipboard to help you. However, 
your ability to paste information to another document is controlled by additional 
permissions set up on the server to which the sealed document is synchronized.

Depending on your permissions on the server:

■ You might be allowed to paste within the same sealed document, but to no other 
document.

■ You might be allowed to paste to a document of the same type, for example from 
one Microsoft Word document to another Microsoft Word document, but not from 
a Microsoft Word document to a Microsoft Excel spreadsheet. 

■ You might be allowed to paste anywhere you want, including to unsealed 
documents.

If you attempt to paste sealed content to an unauthorized destination, Oracle IRM 
Desktop displays a message explaining that you cannot.

4.3 Creating New Sealed Documents
This section covers the following topics:

■ "Using Windows Explorer to Create a New Document that is Sealed from the 
Outset" on page 4-3

■ "Using Microsoft Office to Create a New Document that is Sealed from the Outset" 
on page 4-4

■ "Creating a Sealed Version of an Existing Unsealed Document" on page 4-5

4.3.1 Using Windows Explorer to Create a New Document that is Sealed from the 
Outset

Use the following procedure to create a new document that is sealed from the outset:

1. In Windows Explorer, select the File menu and choose New, then choose the 
Sealed menu item for the document type that you want to create. For example, to 
create a new sealed Word document, choose Sealed Word Document. 

Note: Copying and pasting from sealed HTML is always disabled 
regardless of your rights and permissions.

Note: It is also possible to use the Oracle IRM programming tools to 
create other methods of sealing.

Rights: To seal a document, you need the Seal right. See "About 
Rights" on page 1-2.
                                     Working with Sealed Documents 4-3



Creating New Sealed Documents
2. In the Select Context dialog, select the context to which you want to seal the new 
document.

If the context that you want to use is not shown, try the following, in the order 
given: 

■ Refresh the list by clicking the Refresh Contexts button. 

■ Manually synchronize with the server by right-clicking the Oracle IRM icon in 
the system tray and selecting Synchronize (or by using the Update Rights 
page of the Oracle IRM Desktop Options dialog). 

■ Manually connect to the server hosting the context that you want to use. See 
"Connecting to Oracle IRM Server Manually" on page 7-2.

3. Select a location and enter a name for the new document.

If you have been authorized to allocate item codes manually (see "About Sealed 
Document Item Codes" on page 1-6), you will see an Options section on the dialog 
for naming a document. To set the item code, check the Update Item Code box (if 
not already set), select the Use This Item Code option, then enter an item code in 
the accompanying text box. 

4. Save the new document. 

The new sealed document is opened in the appropriate application, if available. You 
can then work on the sealed document to the extent that your rights allow. 

4.3.2 Using Microsoft Office to Create a New Document that is Sealed from the Outset

If you have enabled integration with Microsoft Office, use the following procedure to 
create a new document that is sealed from the outset:

1. In the Microsoft Office application, select the New Sealed icon on the Oracle IRM 
toolbar, then, on the resultant menu, select the context to which you want to seal 
the document. If the required context is not shown, select the Select Context menu 
item instead. 

2. If you have opened the Select Context dialog, select the context to which you want 
to seal the new document.

If the context that you want to use is not shown, try the following, in the order 
given: 

■ Refresh the list by clicking the Refresh Contexts button. 

■ Manually synchronize with the server by right-clicking the Oracle IRM icon in 
the system tray and selecting Synchronize (or by using the Update Rights 
page of the Oracle IRM Desktop Options dialog). 

■ Manually connect to the server hosting the context that you want to use. See 
"Connecting to Oracle IRM Server Manually" on page 7-2.

3. Select a location and enter a name for the new document.

If you have been authorized to allocate item codes manually (see "About Sealed 
Document Item Codes" on page 1-6), you will see an Options section on the dialog 
for naming a document. To set the item code, check the Update Item Code box (if 

Rights: To seal a document, you need the Seal right. See "About 
Rights" on page 1-2.
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not already set), select the Use This Item Code option, then enter an item code in 
the accompanying text box. 

4. Save the new document. 

The new sealed document is opened. You can then work on the sealed document to 
the extent that your rights allow. 

4.3.3 Creating a Sealed Version of an Existing Unsealed Document

Use one of the following procedures to create a sealed version of a document that 
already exists:

■ In Windows Explorer, select the unsealed document, select the File menu, select 
Seal To, then select Select Context. In the Select Context dialog, select the context, 
then click OK. 

■ If you have enabled integration with Microsoft Office, open the unsealed 
document in the Microsoft Office application and select the Save As Sealed button 
in the Oracle IRM toolbar.

If you have been authorized to allocate item codes manually (see "About Sealed 
Document Item Codes" on page 1-6), you will see an Options section on the dialog for 
naming a document. To set the item code, check the Update Item Code box (if not 
already set), select the Use This Item Code option, then enter an item code in the 
accompanying text box. 

4.4 Saving Changes to Sealed Documents
This section covers the following topics:

■ "About Saving Changes to Sealed Documents" on page 4-5

■ "Saving Changes to A Sealed Document" on page 4-6

4.4.1 About Saving Changes to Sealed Documents
If you have sufficient rights, you can save changes that you make to a sealed 
document. 

It is very unlikely that you will have the right to edit a document but not the right to 
save changes. However, there are occasions when this might be the case. For example, 
you might have the right to change the values in a sealed Microsoft Excel worksheet so 
that you can plot charts for different scenarios and compare various projections, but 
you might not have the right to save changes to the worksheet.

You may want to make changes to a sealed document but save the changes in an 
unsealed copy of the document. See "Unsealing Sealed Documents" on page 4-7. 

Rights: To seal a document, you need the Seal right. See "About 
Rights" on page 1-2.

Caution: When working with plain text files, be aware that any 
format changes or other operations you make that are not supported 
by the text file format will be lost when you save the file, irrespective 
of the text editor that you have used.
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4.4.2 Saving Changes to A Sealed Document

Use the following procedure to save changes to a sealed document:

■ Use the Save or Save As options as usual.

To save a copy of a sealed PDF document, use Internet Explorer's Save As option: the 
Save buttons on the Acrobat and Oracle IRM Desktop toolbars are not available for 
this operation. 

4.5 Changing the Contexts that Documents are Sealed to
This section covers the following topics:

■ "About Changing Contexts" on page 4-6

■ "Changing the Context that a Document is Sealed To" on page 4-6

4.5.1 About Changing Contexts
If you have sufficient rights, you can change the context that a document is sealed to. 
When doing this, you can choose to retain the original document (in a different 
location or with a different name), or you can overwrite the original sealed document. 

During the lifecycle of a particular document, it might be appropriate for it to be 
sealed to different contexts at different times. For example, if you have a document 
sealed to a "work-in-progress" context (see "About Contexts" on page 1-5), you might 
want to change it to a "published" context. Similarly, a document that is highly 
sensitive at the beginning of its lifecycle might become less sensitive after public 
announcements have been made.

4.5.2 Changing the Context that a Document is Sealed To

Use the following procedure to change the context to which a document is sealed: 

1. Right-click the sealed document in Windows Explorer.

2. From the menu, select Reseal To.

3. In the Select Context dialog, select the context that you want to seal the new 
version to, then click OK. 

4. Do one of the following: 

■ To create a copy of the document sealed to the new context, change the 
directory or the file name, then click Save. 

Rights: To save changes to a sealed document, you need the Reseal 
right. See "About Rights" on page 1-2.

Rights: To change the context that a document is sealed to, you need 
the Copy To right for the current context and the Seal right for the 
destination context. See "About Rights" on page 1-2. You may be 
limited to changing to certain trusted contexts. If this is the case, the 
trusted contexts are listed at the bottom of the Rights tab of the Oracle 
IRM Desktop Control Panel, in the Allowed Destinations section. 
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■ To replace the original document, click Save.

4.6 Unsealing Sealed Documents
This section covers the following topics:

■ "About Unsealing Sealed Documents" on page 4-7

■ "Unsealing a Sealed Document" on page 4-7

4.6.1 About Unsealing Sealed Documents
If you have sufficient rights, you can unseal a sealed document (that is, you can make 
an unsealed copy of a sealed document). The unsealed document can then be used 
without restrictions. The rights to do this are usually given only for relatively 
non-sensitive documents. 

4.6.2 Unsealing a Sealed Document

Use the following procedure to unseal a document: 

1. Either: 

Open the sealed document in its normal application and, from the File menu, 
select Save As. 

Or: 

Right-click the document in Windows Explorer and select Unseal. 

2. In the Files of Type drop-down box, select an unsealed file type. 

3. If required, change the location and name of the document, then click Save. 

4.7 Searching Sealed Documents
This section covers the following topics:

■ "About Searching Sealed Documents" on page 4-7

■ "Enabling Windows Search Integration" on page 4-8

■ "Configuring for the Microsoft Indexing Service" on page 4-8

■ "Configuring Search Logging" on page 4-9

4.7.1 About Searching Sealed Documents
You can search sealed documents, subject to your rights, as follows:

■ You can use the search facility provided within any application that displays a 
sealed document that you have the right to open. For example, you could use the 
search facility provided by Microsoft Word to search a sealed Word document that 
you are viewing. This type of search does not require a specific right - you can 
search any sealed document that you can open.

Rights: To unseal a sealed document, you need the Save Unsealed 
right. See "About Rights" on page 1-2. 
                                     Working with Sealed Documents 4-7



Searching Sealed Documents
■ You can use the Windows Explorer search facility to search folders that contain 
sealed documents. If you have the Search right, search results may then include 
matches in sealed documents as well as unsealed documents. 

Searching in Windows Explorer requires you to enable Microsoft Windows search 
integration. Search integration supports sealed Microsoft Office formats, sealed 
HTML, sealed XML, sealed email, and sealed PDF. 

You will usually be given the Search right for any documents for which you have the 
Open right. However, you may be given only the Search right, in which case you will 
be able to search for the content of sealed documents but not open those documents. 

Searching any PDF, including sealed PDF, requires a PDF filter. If the computer from 
which the search is implemented has Adobe Reader installed, it will probably already 
have the necessary filter. If the search is to be implemented from a computer that does 
not normally have Adobe Reader installed, the required filter is, at the time of writing, 
freely downloadable from Adobe. 

If your organization stores large numbers of sealed documents on a file share, it is 
possible to enable the Microsoft Indexing Service to create indexes that include sealed 
documents. Searches of the file share can then find sealed documents more efficiently. 

4.7.2 Enabling Windows Search Integration
Use the following procedure to enable Windows search integration:

1. Open the Oracle IRM Desktop Options dialog. 

You can do this either: 

■ from the Windows Start menu, by selecting Programs, then Oracle IRM 
Desktop, then Options; or 

■ by right-clicking the Oracle IRM icon in the notification area (system tooltray) 
and selecting Options. 

2. On the Search tab, make sure that the Enable Search box is checked. 

4.7.3 Configuring for the Microsoft Indexing Service
You can configure the Oracle IRM Desktop search feature to use the Microsoft 
Indexing Service to support sealed documents.

Use the following procedure to configure Oracle IRM for the Microsoft Indexing 
Service:

1. Open the Oracle IRM Desktop Options dialog. 

You can do this either: 

■ from the Windows Start menu, by selecting Programs, then Oracle IRM 
Desktop, then Options; or 

■ by right-clicking the Oracle IRM icon in the notification area (system tooltray) 
and selecting Options. 

2. On the Search tab, click Advanced.

3. On the Indexing Service Configuration dialog, click New.

4. On the Oracle IRM Server URL page, specify the address of the Oracle IRM Server 
that issues licenses for the sealed documents that you want to be able to index. You 
can find a list of addresses and port numbers on the Servers tab of the Oracle IRM 
Desktop Options dialog.
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4.7.4 Configuring Search Logging
The Oracle IRM Desktop search service writes messages to the Windows event log to 
report the status of the sealed document search. 

Use the following procedure to configure certain aspects of the search logging feature:

1. Open the Oracle IRM Desktop Options dialog. 

You can do this either: 

■ from the Windows Start menu, by selecting Programs, then Oracle IRM 
Desktop, then Options; or 

■ by right-clicking the Oracle IRM icon in the notification area (system tooltray) 
and selecting Options. 

2. On the Search tab, click Settings.

3. On the Search Log Configuration dialog, select the message categories that you 
want written into the Windows event log, then click OK.

4.8 Printing Sealed Documents
This section covers the following topics:

■ "About Printing Sealed Documents" on page 4-9

■ "Printing a Sealed Document" on page 4-9

4.8.1 About Printing Sealed Documents
There are two print rights for sealed documents, the Print right and the Print To File 
right. See "About Rights" on page 1-2. If you have one of these rights for a particular 
sealed document, you can print it as if it were an unsealed document. If you do not 
have a print right for a document, the relevant print menu options and toolbars are 
disabled.

4.8.2 Printing a Sealed Document

Use the following procedure to print a sealed document:

1. Using the usual application for the document type, open the document that you 
want to print.

2. Use the usual method for printing a document.  For example, select the File menu, 
then select Print. 

4.9 Screen Capturing Sealed Documents
This section covers the following topics:

■ "About Screen Capturing Sealed Documents" on page 4-10

■ "Sharing a Sealed Presentation During a Web Conference" on page 4-10

Rights: To send a sealed document to a printer, you need the Print to 
File right or the Print right. To print a sealed document to a file, you 
need the Print to File right. The Print to File right includes the Print 
right. See "About Rights" on page 1-2.
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■ "Capturing the Image of a Sealed Document" on page 4-10

4.9.1 About Screen Capturing Sealed Documents
Oracle IRM Desktop controls your use of screen capture mechanisms, including the 
mechanisms used by popular web conferencing applications.

If you have the right to screen capture, then you can do so in the usual way.

If you do not have the right to screen capture, Oracle IRM Desktop uses an image to 
mask sealed documents when you invoke the capture operation. 

4.9.2 Sharing a Sealed Presentation During a Web Conference

Use the following procedure to share a sealed presentation:

1. Start the web conference.

2. Share the sealed presentation as if it were an unsealed presentation. 

If you do not have the Screen Capture right, remote observers will see a blanking 
image comprising numerous Oracle IRM logos. 

4.9.3 Capturing the Image of a Sealed Document

Use the following procedure to capture an image of a sealed document from the 
screen:

1. Capture the image in the usual way. For example, Alt+PrintScreen.

2. Paste the captured image into the destination application. For example, in 
Microsoft Word, select the point at which you want the image to be inserted, then 
select the Edit menu and select Paste.

If you do not have the Screen Capture right, an image comprising numerous Oracle 
IRM logos will be pasted into the destination application instead of the captured 
image. 

4.10 Sharepoint Behavior
Sealed files in Microsoft Office SharePoint are opened read-only regardless of user 
rights.

To edit the file, copy it to your local file system (for example, the My Documents folder 
of Windows Desktop), make your changes, save the file, then upload it to SharePoint.

4.11 Using Sealed Microsoft Excel Spreadsheets
This section covers the following topics:

Rights: To start a web conference and share a sealed presentation, 
you need the Screen Capture right. See "About Rights" on page 1-2.

Rights: To capture the image of a sealed document from the screen, 
you need the Screen Capture right. See "About Rights" on page 1-2.
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■ "About Sealed Microsoft Excel Spreadsheets" on page 4-11

■ "Linking Sealed Microsoft Excel Spreadsheets" on page 4-11

■ "Updating Links Between Previously Unsealed Spreadsheets" on page 4-12

4.11.1 About Sealed Microsoft Excel Spreadsheets
The Oracle IRM solution for opening, editing, creating, resealing, and searching sealed 
documents is as applicable to Microsoft Excel spreadsheets as it is to other Microsoft 
Office documents. What you are able to do with Microsoft Excel spreadsheets is 
determined by the usual sealed document rights, such as Open, Edit, Seal, and Search. 
See "About Rights" on page 1-2. Additionally, the Formulae right determines whether 
formulae (formulas) are revealed or concealed in sealed spreadsheets.

The ability to display content from one sealed workbook in the cells of another sealed 
workbook is supported. This is the facility in Microsoft Excel to set up a link between 
workbooks by copying data (using the Copy command on the Edit menu) from a cell 
in one workbook and then pasting it (using the Paste Special command on the Edit 
menu) into a cell in the other workbook. 

Oracle IRM allows such links between workbooks only if both workbooks are sealed 
to the same context.

Oracle IRM will prevent unauthorized access to data. This means that if a link is 
created to a sealed workbook from an unsealed one, or if the user of one sealed 
workbook is not authorized to see the content of a sealed workbook linked to it, the 
content of a linked cell will be shown as "#REF".

Just as with other types of document, you can use Oracle IRM fields (see "Working 
With Oracle IRM Fields and Watermarks" on page 6-1) to help reinforce the 
confidential nature of a Microsoft Excel spreadsheet.

4.11.2 Linking Sealed Microsoft Excel Spreadsheets
Linking Microsoft Excel spreadsheets usually involves copying the contents of a cell in 
one spreadsheet and pasting it (using Paste Special) into the cell of another 
spreadsheet. This means that any changes made to the cell in the first spreadsheet will 
be reflected in the second spreadsheet.

However, to protect the cell content of sealed spreadsheets, there are restrictions on the 
use of Copy and Paste Special between separately opened Microsoft Excel workbooks: 
if you do not have copy rights (Copy or Copy To), the content will be pasted as fixed 
text, and not as text that will be updated when the source workbook changes. 

Note: If the pasted content is derived from data in cells in the same 
document (for example, a chart created from nearby data cells), the 
pasted content will not show in the destination document. 
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4.11.3 Updating Links Between Previously Unsealed Spreadsheets

Use the following procedure to update existing links in spreadsheets that were 
previously unsealed:

1. Seal both the source and the destination spreadsheet files.

2. Open the sealed destination spreadsheet file.

You will see the Microsoft Excel message telling you that there are links to other 
data sources.

3. Only if you have already sealed the source spreadsheet file, accept the option to 
update the links.

You will see the Microsoft Excel message telling you that there are links that 
cannot be updated. (This is because the file extensions have been changed from 
.xls to .sxls.)

4. Accept the option to edit the links.

You will see a list of links with the status "Error: Source not found".

5. Use the dialog's change source facility to search for the sealed source file (with a 
.sxls extension).

6. If prompted to, log in to the sealed source file.

The links between the sealed spreadsheet files are re-established.

4.12 Using Sealed Microsoft Office templates
This section covers the following topics:

■ "About Using Sealed Microsoft Office Templates" on page 4-12

■ "Creating a Sealed Microsoft Office Template from within Microsoft Office" on 
page 4-13

■ "Creating a Sealed Microsoft Office Template using Windows Explorer" on 
page 4-13

■ "Editing Sealed Microsoft Office Templates" on page 4-14

4.12.1 About Using Sealed Microsoft Office Templates
Sealed templates have the same benefits as ordinary templates: they enable you to 
create new documents in a simple and consistent way. However, when you use a 

Caution: If you have existing unsealed spreadsheet files with links 
between them, seal all the files before updating the links between 
them. If you seal only the destination spreadsheet and then try to 
update the links to a pre-existing unsealed source, the links will be 
destroyed and will not be recoverable.

Rights: To open a sealed spreadsheet, you need the Open right. To 
seal a spreadsheet, you need the Seal right. To see formulas on a 
sealed spreadsheet, you need the Formulae right. See "About Rights" 
on page 1-2. 
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sealed template, the new document is sealed to the same context as the template. For 
example, if a template is sealed to the Top Secret context, then all documents created 
from it are sealed to the Top Secret context too. 

4.12.2 Creating a Sealed Microsoft Office Template from within Microsoft Office

Use the following procedure to create a sealed template from within Microsoft Office 
(this uses Microsoft Word as an example):

1. Make sure that Microsoft Office integration is enabled:

a. Right-click the Oracle IRM icon in the system tooltray and select Options.

b. On the Oracle IRM Desktop Options dialog, select the General tab.

c. Make sure that the Enable Microsoft Office support checkbox is checked. 

2. Open a Microsoft Word template that you want to seal, or open a Microsoft Word 
document that you want to save as a sealed template.

3. On the Oracle IRM Desktop toolbar, click the Save as Sealed icon .

4. Select a context for the sealed template.

After selecting a context, Microsoft Office displays a dialog to enable you to name 
the file and specify its type.

5. Specify Save as Type: Sealed Word Template (*.sdot), if present.

For Microsoft Office 2007, select *.sdotx or *.sdotm as appropriate.

6. Specify an appropriate name and location for the template, and save it.

The document is saved as a sealed template, and immediately opened with Oracle 
IRM Desktop for you to continue editing if required.

4.12.3 Creating a Sealed Microsoft Office Template using Windows Explorer

Use the following procedure to create a sealed template using Windows Explorer:

1. In Windows Explorer, select an unsealed template (.dot, .xlt, or .pot).

2. Right-click the selected template.

3. Select Seal To and the context that you want documents created from this template 
to be associated with. 

Rights: To open a sealed template or document, you need the Open 
right. To seal an unsealed template or document, you need the Seal 
right. To edit a sealed template, you need the Edit right, or an 
associated right. To save changes made to a sealed template, you need 
the Reseal right. See "About Rights" on page 1-2.

Rights: To seal an unsealed template, you need the Seal right. See 
"About Rights" on page 1-2.
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4.12.4 Editing Sealed Microsoft Office Templates

Use one of the following procedures to edit an existing sealed template:

■ In Windows Explorer, select the sealed template, select the File menu, select  
Open, edit the document, then save it.

■ While using the relevant Microsoft Office application, select the File menu, then 
select Open. You can then use the Files of Type field on the Open dialog to specify 
that you want to open a sealed template. Edit the document, then save it. 

Rights: To open a sealed template, you need the Open right. To edit 
a sealed template, you need the Edit right, or an associated right. To 
save changes to a sealed template, you need the Reseal right. See 
"About Rights" on page 1-2.
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5Using Sealed Email

This section covers the following topics:

■ "Creating and Sending Sealed Email" on page 5-1

■ "Opening Sealed Email" on page 5-3

■ "Creating Sealed Email Replies" on page 5-3

■ "Forwarding Sealed Email" on page 5-4

5.1 Creating and Sending Sealed Email
This section covers the following topics:

■ "About Creating and Sending Sealed Email" on page 5-1

■ "Creating and Sending Sealed Email using an Integrated Email Application" on 
page 5-2

■ "Creating and Sending Sealed Email using an Existing Document Attachment" on 
page 5-2

■ "Creating and Sending Sealed Email using Sealed Email Document Format" on 
page 5-2

5.1.1 About Creating and Sending Sealed Email

There are two main ways to create sealed email, subject to your rights and the software 
that you have installed on your system:

■ If you use Microsoft Outlook or Lotus Notes, powerful sealing options can be 
integrated directly into your email application. You can mark an email to be sealed 
as it is sent. This allows the very easy sealing of new emails, replies, and 
forwarded emails. Replying and forwarding of sealed emails are handled very 
much like regular replying and forwarding, enabling you to participate in email 
threads where all the messages are sealed.

■ You can use any email application to send any sealed document as an attachment. 
The attachment can be any sealed document, including one that has been created 
specially as a sealed email document using the facility added to Windows 
Explorer. The advantage of using the special sealed email document format is that 
your message will look and behave more like a regular email for any recipients 
who use Oracle IRM Desktop. 

Note: The recipient of a sealed email will be able to read it only if he 
has Oracle IRM Desktop installed on his computer and he has been 
given sufficient rights. It is recommended that you insure intended 
recipients have Oracle IRM Desktop installed or know how to obtain 
it, especially if you send emails outside your own organization. 
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5.1.2 Creating and Sending Sealed Email using an Integrated Email Application

Use the following procedure to create and send sealed email using an integrated email 
application (Microsoft Outlook or Lotus Notes):

1. Enable integration with your email application by doing the following: 

a. Open the Oracle IRM Desktop Options dialog (either from the Windows Start 
menu or from the Oracle IRM icon in the notification area).

b. Select the Email tab.

c. Select the checkbox against the name of your email application, then click OK.

2. In your email application, click the New Sealed Email button.

3. In the message creation window of your email application, make sure that the Seal 
on Send button is in the pressed down position. 

4. Write your email and go to send it in the usual way.  You will be asked to select a 
sealing context before the message is sent. 

5.1.3 Creating and Sending Sealed Email using an Existing Document Attachment

Use the following procedure to send sealed email using an existing document that 
contains the information to be sent:

1. If the document to be sent is unsealed, seal it in the usual way.

2. In your email application, create a message, attach the sealed document, and send 
it in the usual way. 

5.1.4 Creating and Sending Sealed Email using Sealed Email Document Format

Use the following procedure to create and send a sealed email using an attachment in 
the sealed email document format:

1. Open Windows Explorer, select the File menu, select New, then select Sealed 
Email Message. 

2. In the Context Selection dialog, select the context in which the message will be 
sealed. 

3. In the Save As dialog, select the name and location for the sealed document. Make 
sure that the Open new sealed document box is checked. 

Rights: To create a new sealed email and send it, you need the Seal 
right. See "About Rights" on page 1-2. 

Rights: To seal a document, and to send it by sealed email, you need 
the Seal right. See "About Rights" on page 1-2.

Rights: To create a document in sealed email format, you need the 
Edit right. To send a sealed email, you need the Seal right. See "About 
Rights" on page 1-2.
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4. Write the message into the document application that is opened (usually Microsoft 
Word). 

5. Save and close the document. 

6. In your email application, create a message, attach the sealed document, and send 
it in the usual way. 

5.2 Opening Sealed Email

A sealed email message always reaches the recipient as an attachment to a regular 
email. 

Use one of the following procedures to open a sealed email message:

■ In the email application, open the sealed attachment in the same way that you 
would open a regular attachment.

■ Save the sealed attachment to disk, then open it from Windows Explorer by 
double-clicking it. 

5.3 Creating Sealed Email Replies
You can create sealed replies to unsealed emails, and you can reply to sealed emails to 
create sealed email threads.

This section covers the following topics:

■ "Creating a Sealed Reply to an Unsealed Message" on page 5-3

■ "Replying to a Sealed Email" on page 5-4

5.3.1 Creating a Sealed Reply to an Unsealed Message

Use the following procedure to create a sealed reply to an unsealed email message:

1. In your email application, click the Reply button.

2. In the message creation window, make sure that the Seal on Send button is in the 
pressed down position. 

3. Write your reply and go to send it in the usual way.  You will be asked to select a 
sealing context before the reply is sent. 

Rights: To open a sealed email, you need the Open right. See "About 
Rights" on page 1-2.

Rights: To create a sealed reply to an unsealed email message, you 
need the Seal right. See "About Rights" on page 1-2.
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5.3.2 Replying to a Sealed Email

Use the following procedure to reply to a sealed email (that is, an email with a sealed 
attachment):

1. In your email application, open the sealed email attachment.

2. Click the Oracle IRM Reply button or Reply to All button.

3. In the document application that is opened, write your reply. 

The original sealed text will be visible in the document application, and will be 
indented, as will the text of any subsequent sealed replies. 

4. Choose one of the following options:

■ To save the reply text and send it immediately, click the Send Now button.

■ To save the reply text and attach it to an outgoing email, ready for sending 
later, click the Save and Attach button.

The reply will be sealed to the same context as the original sealed email.

5.4 Forwarding Sealed Email
Using the integrated email applications, you have a choice of ways to forward sealed 
email.

This section covers the following topics:

■ "Forwarding Sealed Email without Amendment" on page 5-4

■ "Forwarding Sealed Email with Amendments" on page 5-5

■ "Sealing and Forwarding an Email that was Received Unsealed" on page 5-5

5.4.1 Forwarding Sealed Email without Amendment

Use the following procedure to circulate a sealed email to other recipients (this uses 
Microsoft Outlook as an example): 

1. Select or open the sealed email.

2. Click Forward.

Outlook opens the sealed email so that you can specify the addresses that you 
want to forward it to. The sealed email is displayed as an attachment.

3. Specify the recipients, and optionally amend the unsealed introductory text that 
forms part of all sealed email.

4. Click Send.

Rights: To reply to a sealed email, you need the Reply right or the 
Reply Tracked right. To save changes that you make to a sealed email, 
you need the Reseal right. See "About Rights" on page 1-2.

Rights: To forward a sealed email without amendment, you need the 
Open right. See "About Rights" on page 1-2.
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The message is forwarded to the specified recipients with its sealed attachment 
unaltered. The recipients can open the sealed attachment subject to their rights, as 
usual.

5.4.2 Forwarding Sealed Email with Amendments

Use the following procedure to add some comments to a sealed email before 
forwarding it to other recipients (this uses Microsoft Outlook as an example):

1. Open the message and open its sealed attachment.

Outlook opens a window to display the sealed attachment. This window is 
read-only (just as regular email windows are read-only).

2. Click Forward in the window of the sealed attachment.

Outlook creates a new window to display an editable version of the sealed 
attachment (just as it opens a new, editable window when you click Forward on a 
regular message).

3. Edit the sealed email as required.

The original sealed email message is indented, just as Microsoft Outlook usually 
indents forwarded messages in email threads. You can add some text to the top of 
the message, or amend the text of the original message, as usual.

4. When ready, click Save and Attach.

Microsoft Outlook attaches the amended message to an email that you can address 
and send as usual.

5.4.3 Sealing and Forwarding an Email that was Received Unsealed

This option is useful if someone sends you a message that you think should be sealed, 
or if you want to add some confidential remarks to a message before forwarding it.

Use this procedure to forward and seal an email that you received unsealed (this uses 
Microsoft Outlook as an example):

1. With the unsealed message open or selected, click Forward.

2. In the message editing window, click the Seal on Send button at any time before 
sending the message.

3. When you have finished adding any additional text and inserted the addressees, 
send the message (select the File menu and select Send). 

4. From the Select Context dialog, select a context and click OK.

The original unsealed message is fowarded as a sealed attachment to the email. 

Rights: To forward a sealed email with amendments, you need the 
Seal right and a reply right (Reply or Reply Tracked). See "About 
Rights" on page 1-2.

Rights: To seal and forward an email that was received unsealed, 
you need the Seal right. See "About Rights" on page 1-2.
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6Working With Oracle IRM Fields and
Watermarks

This section covers the following topics:

■ "About Oracle IRM Fields and Watermarks" on page 6-1

■ "Adding Oracle IRM Fields in Microsoft Word" on page 6-1

■ "Adding Oracle IRM Fields in Microsoft Excel" on page 6-3

6.1 About Oracle IRM Fields and Watermarks
Oracle IRM fields are placeholders for information about a sealed document, for 
example the name of the user who sealed the document, or the context to which the 
document is sealed. You insert Oracle IRM fields into documents before or after they 
are sealed. When Oracle IRM Desktop opens a sealed document that contains an 
Oracle IRM field, it transforms the field into the relevant item of information. 

A document can contain many Oracle IRM fields. For a list of all the Oracle IRM fields, 
see "List of Oracle IRM Fields" on page 8-1.

A common use for Oracle IRM fields is to create watermarks in sealed documents. The 
watermarks will show on all instances of the sealed document. This can be used, for 
example, to help trace the origin of a sealed document that has been printed. 

6.2 Adding Oracle IRM Fields in Microsoft Word
This section covers the following topics:

■ "Adding an Oracle IRM Field to a Microsoft Word Document" on page 6-1

■ "Registering Oracle IRM Fields as Microsoft Word Document Properties" on 
page 6-2

■ "Using Oracle IRM Fields that have been Registered as Microsoft Word Document 
Properties" on page 6-2

6.2.1 Adding an Oracle IRM Field to a Microsoft Word Document
For typical uses of Oracle IRM fields, see "About Oracle IRM Fields and Watermarks" 
on page 6-1.

You can add fields anywhere in an unsealed Microsoft Word document. However, if 
you add them to headers and footers, they are repeated consistently on every page of a 
document, and can be used as a watermark that lies behind the main content of the 
page.

Use the following procedure to add an Oracle IRM Field to a Microsoft Word 
document:

Rights: To complete this procedure you will need the Seal right, and 
to see transformed fields in sealed documents you will need the Open 
right as a minimum. See "About Rights" on page 1-2.
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1. Open an unsealed Microsoft Word document and position the cursor in the 
document to indicate where you want the field to appear.

2. Select the Insert menu, then select Field.

3. Select Document Information from the list of categories.

4. Select DocProperty from the list of field names.

5. Edit the text field beneath the two lists so that it identifies the Oracle IRM field you 
want to use. For example: 

DOCPROPERTY "irm-account-name"

For the complete list of Oracle IRM fields, see "List of Oracle IRM Fields" on 
page 8-1.

6. Click OK. 

The string Error! Unknown document property name appears at the cursor. This 
is not a problem, but can be avoided as described in "Registering Oracle IRM 
Fields as Microsoft Word Document Properties" on page 6-2. 

7. Save and close the Microsoft Word document.

8. Seal the Microsoft Word document.

When you open the sealed Microsoft Word document, the Oracle IRM field is 
transformed.

6.2.2 Registering Oracle IRM Fields as Microsoft Word Document Properties
You can simplify the use of Oracle IRM fields by registering them as Microsoft Word 
document properties. This procedure can be used to avoid an unhelpful error message 
being shown as a placeholder for the field data, as described in"Adding an Oracle IRM 
Field to a Microsoft Word Document" on page 6-1. 

Use the following procedure to register a field as a document property:

1. Open an unsealed Microsoft Word document.

2. Select the File menu, then select Properties.

3. Select the Custom tab.

4. Type the name of an Oracle IRM field, for example, irm-account-name.

For the complete list of Oracle IRM fields, see "List of Oracle IRM Fields" on 
page 8-1.

5. Specify a value, for example, "This field will be updated when sealed".

6. Click OK.

6.2.3 Using Oracle IRM Fields that have been Registered as Microsoft Word Document 
Properties

Having registered the field, it is available as an option next time you use the Field item 
on the Insert menu. The specified value appears in the Word document instead of the 
placeholder string.

Rights: This procedure does not require any Oracle IRM rights.
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Use the following procedure to use a registered Oracle IRM field:

1. Open an unsealed Microsoft Word document and position the cursor in the 
document to indicate where you want the field to appear.

2. Select the Insert menu, then select Field.

3. Select Document Information from the list of categories.

4. Select DocProperty from the list of field names.

5. Click the Options button, select the Oracle IRM field from the list of properties, 
then click the Add to Field button.

6. Click OK to close the Field Options dialog.

7. Click OK to close the main Field dialog.

The value of the field appears at the cursor.

8. Save and close the Microsoft Word document.

9. Seal the Microsoft Word document.

When you open the sealed Microsoft Word document, the field is transformed.

6.3 Adding Oracle IRM Fields in Microsoft Excel

Use the following procedure to add an Oracle IRM field to a cell on a Microsoft Excel 
spreedsheet:

1. Open the Microsoft Excel spreadsheet and select the cell in which you want the 
field to appear.

2. Select the Insert menu, then select Function.

3. From the Function category list, select Oracle IRM Add-in.

4. From the Function name list, select OracleIRM_IRMProp.

5. Click OK.

6. In the Name box of the entry panel, enter the distinguishing portion of the field 
name.

For example, to insert the field irm-account-name, enter "account-name".

For the complete list of Oracle IRM fields, see "List of Oracle IRM Fields" on 
page 8-1.

7. Click OK.

8. Seal the Micosoft Excel document.

Rights: To complete this procedure you will need the Seal right, and 
to see transformed fields in sealed documents you will need the Open 
right as a minimum. See "About Rights" on page 1-2.

Rights: To complete this procedure you will need the Seal right, and 
to see transformed fields in sealed documents you will need the Open 
right as a minimum. See "About Rights" on page 1-2.
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7Managing Oracle IRM Rights

This section covers the following topics:

■ "About Obtaining and Managing Your Rights" on page 7-1

■ "Connecting to Oracle IRM Server Manually" on page 7-2

■ "Synchronizing Your Rights Manually" on page 7-2

■ "Checking In Your Rights Manually" on page 7-3

7.1 About Obtaining and Managing Your Rights
After initial connection to Oracle IRM Server, managing your rights is almost 
completely automatic. 

When you attempt to open a sealed document that you have obtained or been sent, the 
Oracle IRM client software automatically contacts Oracle IRM Server to obtain your 
rights. If you have sufficient rights, you will be able to use the sealed document. 

After you have established a connection to Oracle IRM Server, you may, if you have 
sufficient rights, be able to create new documents sealed to a context on that server. If 
you have not already connected to Oracle IRM Server (for example, by opening a 
document that someone else has sealed to that server), you will have to connect to the 
server manually (see "Connecting to Oracle IRM Server Manually" on page 7-2). 

Depending on how Oracle IRM has been configured, you might be prompted for your 
Oracle IRM credentials (user name and password). 

Having requested your rights for the particular document you wanted to open, the 
software also sets up periodic rights synchronization. This automatic process means 
that you typically have all of your rights available to you even if Oracle IRM Server is 
temporarily unavailable. This enables you to work offline without further preparation.

In some circumstances, you might want to manage your rights manually. For example:

■ If you are about to disconnect from the network and you want to be sure that your 
cached rights are as up-to-date as possible, you can synchronize manually.

Note: Because Oracle IRM Server will store data that allows you to 
be personally identified, on first contact with the server you will see a 
dialog asking you to confirm that you have read and accept the 
privacy policy associated with the sealed document. To use the sealed 
document, you must accept the privacy policy. You can cancel at this 
stage, in which case the document will not be shown, and no 
information about you will be stored on the server. This applies to 11g 
servers only and differs from previous releases of Oracle IRM. 

Note: For offline working, you will usually not be asked for a 
username and password when accessing a sealed document. This is 
because authentication for offline working is based on your Windows 
login. 
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■ If you want to change the computer on which you are reading sealed documents 
(for example, to work on a home PC), you may need to check in your rights to 
Oracle IRM Server. This is because a license can be used by only one computer at a 
time, unless Oracle IRM Server has been specifically configured to allow the use of 
multiple computers. When you check in, any open documents using your rights 
are closed. Another computer can then synchronize to the server, with the same 
account, and obtain those rights.

7.2 Connecting to Oracle IRM Server Manually
The easiest way to connect to Oracle IRM Server is to open a document that has 
already been sealed to a context on that server. If this is not possible, you will have to 
connect to the server manually. 

Use the following procedure to connect to Oracle IRM Server manually:

1. From the Windows Start menu, select Programs, then Oracle IRM Desktop, then 
Options. 

This opens the Oracle IRM Desktop Options dialog. 

Alternatively, you can right-click the Oracle IRM icon in the notification area 
(system tray) and select Options. 

2. On the Servers tab, select New.

3. On the Add Server dialog, enter the URL of the server. 

The URL will be in the form  https://irm.example.com/irm_desktop although 
you will probably have to obtain the exact URL from the administrator of the 
server.  The /irm_desktop extension is required. 

4. To check that the connection can be made, select Validate.

5. To connect to the server, select OK.

If the connection details are valid, the server will be added to the list on the Servers 
tab. 

7.3 Synchronizing Your Rights Manually

Use the following procedure to synchronize your rights manually:

1. From the Windows Start menu, select Programs, then Oracle IRM Desktop, then 
Synchronization and Check In. 

This opens the Oracle IRM Desktop Options dialog. 

Note: You will have to synchronize your rights manually if you 
choose not to save your credentials at the initial login dialog, or if you 
use form-based authentication.

Note: By following this procedure, your rights will be synchronized 
on servers where the Update Rights box is checked on the Servers tab 
of the Oracle IRM Desktop Options dialog. If there are servers that 
you do not want to synchronize with, uncheck the box on the Servers 
tab first. 
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2. On the Update Rights tab, select Synchronize.

Alternatively, you can right-click the Oracle IRM icon in the Windows system tray and 
select Synchronize. 

7.4 Checking In Your Rights Manually

Use the following procedure to check in your rights manually:

1. From the Windows Start menu, select Programs, then Oracle IRM Desktop, then 
Synchronization and Check In. 

This opens the Oracle IRM Desktop Options dialog. 

2. On the Update Rights tab, select Check In.

Alternatively, you can right-click the Oracle IRM icon in the Windows system tray and 
select Check In. 

Note: By following this procedure, your rights will be checked in on 
servers where the Update Rights box is checked on the Servers tab of 
the Oracle IRM Desktop Options dialog. If there are servers that you 
do not want to check your rights into, uncheck the box on the Servers 
tab first. 
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8Oracle IRM Desktop Reference

This section covers the following topics:

■ "List of Oracle IRM Fields" on page 8-1

■ "Frequently Asked Questions" on page 8-2

■ "Troubleshooting" on page 8-5

■ "Formats" on page 8-6

8.1 List of Oracle IRM Fields
The Oracle IRM solution supports a number of fields that you can add to documents 
before sealing them. When Oracle IRM Desktop opens a document that contains an 
Oracle IRM field, it transforms the field into the relevant item of information. A 
document can contain many Oracle IRM fields. 

Typically, the following two fields provide a sufficient reminder of the sensitive nature 
of a document, and the user responsible for opening a particular copy:

■ irm-account-name

■ irm-classification-name

The complete list of Oracle IRM fields that you can consider using is as follows:

■ irm-time

All fields that end with -time will show Coordinated Universal Time (UTC).

■ irm-time-local

All fields that end with -time-local will show the local time, with the number of 
hours ahead or behind UTC included in parentheses. 

■ irm-locale

■ irm-location

■ irm-mime

■ irm-extension

■ irm-account-uuid

■ irm-account-name

■ irm-creation-time

■ irm-creation-time-local

■ irm-edit-time

■ irm-edit-time-local

■ irm-schema-version

■ irm-classification-name

■ irm-classification-description

■ irm-classification-xml
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■ irm-classification-keyset

■ irm-classification-system

■ irm-classification-time

■ irm-classification-time-local

■ irm-classification-uri

■ irm-host

■ irm-context-itemcode-value

■ irm-context-itemcode-time

■ irm-context-itemcode-time-local

■ irm-context-uuid

Fields with the former SealedMedia_ and OracleIRM_ name prefixes will continue to 
be recognized for the foreseeable future.

8.2 Frequently Asked Questions
This section covers the following topics:

■ "I have been prompted to log in manually, and I have forgotten my credentials. 
What do I do?" on page 8-3

■ "I have logged in successfully but Oracle IRM Desktop says I do not have the 
rights to access a document. What do I do?" on page 8-3

■ "When I log in I get a "Cannot connect to server" message. What do I do?" on 
page 8-3

■ "I had a sealed document open and it just disappeared. What's happened?" on 
page 8-3

■ "I am no longer able to edit the document I am working with. What's happened?" 
on page 8-3

■ "I have got two sealed documents from the same originator, but I can access only 
one of them. Why?" on page 8-4

■ "Why has my account been locked out?" on page 8-4

■ "Why can't I work with sealed Microsoft Office documents in the same way I work 
with normal ones?" on page 8-4

■ "I have heard that email messages and threads can be sealed, but I don't know 
how. What do I do?" on page 8-4

■ "I have heard that I can use templates to create sealed documents, but I don't know 
how. What do I do?" on page 8-4

■ "I have heard that I can add distinctive watermarks and headers and footers to 
sealed documents, but I don't know how. What do I do?" on page 8-4

■ "How do I save changes I have made to VB code in a sealed document?" on 
page 8-4
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8.2.1 I have been prompted to log in manually, and I have forgotten my credentials. 
What do I do?

If you have access to a password reset page, browse to that page and use it to reset 
your password. Otherwise, contact an Oracle IRM Server administrator for assistance. 
See "Obtaining Technical Support" on page 8-5.

8.2.2 I have logged in successfully but Oracle IRM Desktop says I do not have the 
rights to access a document. What do I do?

Oracle IRM Desktop usually redirects you to a web page that provides contact details 
for the person who can give you the rights you need. Contact that person and explain 
which document you are trying to open, and why you need access to it. They will 
decide whether it is appropriate to give you any rights.

If you see a message saying that your rights are already checked out to another 
computer, you need to check in your rights from that computer, or wait for the rights 
to expire. 

8.2.3 When I log in I get a "Cannot connect to server" message. What do I do?
If you cannot connect to the Oracle IRM server, there may be a problem with your 
network connection. If you connect to the Internet from a corporate network, you may 
need assistance from your network administrator to resolve the problem. Use the 
Oracle IRM Server Connection Test dialog to diagnose the problem. (Open this dialog 
from the Test link on the page that reported the error.)

If you see this message for only some documents, but can open others, then it is 
possible that you are being served by multiple Oracle IRM servers, one of which is 
temporarily unavailable.

8.2.4 I had a sealed document open and it just disappeared. What's happened?
Your rights have expired and you have been redirected to a web page. 

If you are working offline, then go online and try to open the document again. It is 
possible that your locally cached rights have expired and that more rights can be 
obtained as soon as you go online. 

If your rights have expired permanently, then the web page should provide contact 
details for the administrators who are authorized to grant you more rights. 

If you were editing a sealed document online when your rights expired or were 
revoked, you will lose any unsaved changes. If your rights were downgraded, or if 
your locally cached rights expired, you are given an opportunity to save changes. 

8.2.5 I am no longer able to edit the document I am working with. What's happened?
This is rare, but it is possible that your rights have been reduced since you started 
working on the document. If you think this might be the case, contact the owner of the  
context to which the document is sealed. Contact details are usually available by 
clicking the Online Information icon on the Oracle IRM Desktop toolbar.
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8.2.6 I have got two sealed documents from the same originator, but I can access only 
one of them. Why?

It is quite usual for documents to be sealed to different contexts even if they come from 
the same originator. For example, you might receive documents sealed to a "Company 
Confidential" context and others sealed to a "Board Matters" context. It is likely that 
your rights for these two contexts will be different, such that you can only open one, or 
you can open them both, but edit only one.

8.2.7 Why has my account been locked out?
As a security measure, the Oracle IRM Server administrator has configured an account 
lock-out policy that prevents anyone from trying to guess passwords. If your account 
has been locked out, it is possible that someone else has been trying to log in using 
your account. Depending on the lock-out policy, your account might become 
accessible again after a short period, or might need to be manually reset. Contact your 
Oracle IRM Server administrator for further information.

8.2.8 Why can't I work with sealed Microsoft Office documents in the same way I work 
with normal ones?

The purpose of sealing documents is to control who has access, and who has edit 
rights. Edit rights are fine-grained, so you might find that you cannot use all of the 
Microsoft Office features you are familiar with. For example, you might find that you 
cannot print a sealed document, or that you are prevented from pasting information 
from one sealed document to another, or that the track changes option is always on.

Oracle IRM's goal is that using sealed documents should be very similar to using 
unsealed documents, if you have the necessary set of rights. Where rights are granted, 
you should be able to do what you usually do in most cases. In some cases, the need to 
protect a document might mean that options you are familiar with need to be disabled 
because they provide security loopholes.

8.2.9 I have heard that email messages and threads can be sealed, but I don't know 
how. What do I do?

See "Using Sealed Email" on page 5-1. To use sealed email to full advantage, you need 
to use enable email integration in Oracle IRM Desktop.

8.2.10 I have heard that I can use templates to create sealed documents, but I don't 
know how. What do I do?

See "Using Sealed Microsoft Office templates" on page 4-12. 

8.2.11 I have heard that I can add distinctive watermarks and headers and footers to 
sealed documents, but I don't know how. What do I do?

See "Working With Oracle IRM Fields and Watermarks" on page 6-1.

8.2.12 How do I save changes I have made to VB code in a sealed document?
To maintain the security of the VB code, it is not possible to save your VB code changes 
directly in the sealed document. 
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Troubleshooting
Use the following procedure to save changes that you have made to VB code in a 
sealed document:

1. Select the container document for the VB code document that you have changed.

2. Select Save in the container document.

8.3 Troubleshooting
This section covers the following topics:

■ "Obtaining Technical Support" on page 8-5

■ "Proxy Issues" on page 8-5

■ "Sealed Documents Block Screen Captures" on page 8-6

8.3.1 Obtaining Technical Support
Use the following procedure to begin the process of obtaining technical support:

1. Close the Oracle IRM Desktop Control Panel, if necessary, using the Cancel button.

2. On the Oracle IRM Desktop toolbar, click the Online Information button.

A browser window opens and provides information about how to get technical 
support relating to the sealed document you are currently viewing, or trying to view, 
and the Oracle IRM Server that provides the licenses for that document.

The contact information can be different for different sealed documents, especially if 
the documents come from different servers.

8.3.2 Proxy Issues
Oracle IRM Desktop needs to be able to communicate with an Oracle IRM Server 
instance to get licenses so that you can open sealed documents.

Oracle IRM Desktop communicates with 10g versions of Oracle IRM Server using a 
secure, encrypted variant of the HTTP protocol used by web browsers. Your network 
configuration might prevent this protocol from reaching Oracle IRM Server. For 11g 
versions of Oracle IRM Server, standardized HTTP or HTTPS communications are 
used. 

There are two types of network configuration that can cause problems:

■ Proxy servers

Your network might require Oracle IRM Desktop communications to pass through 
a particular computer, known as a proxy server. If so, then your browser also 
needs to use a proxy server, and should already have the required proxy server 
settings. Oracle IRM Desktop uses the same settings, so proxy servers should not 
cause problems.

However, if your Oracle IRM Desktop is failing to communicate with Oracle IRM 
Server, and Oracle IRM Desktop tests report that there is a proxy server, report the 
problem to your network administrator.

The use of proxy servers with indexed search integration will be problematic and 
is not advised. 

■ Firewalls
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A firewall monitors all communications between your local network and remote 
networks, and prevents any communications that it considers a security risk. 
Oracle IRM Desktop uses standard web browsing protocol. If your firewall allows 
you to browse the world wide web, you should also be able to communicate with 
Oracle IRM Server.

If browsing the web is not permitted, you need to talk to your network 
administrator to arrange to allow communications to Oracle IRM Server. The 
firewall needs to allow outbound connections to the Oracle IRM Server address 
and port, and allow responses to such connections.

You can use the Oracle IRM Desktop test facility to find out what address and port 
Oracle IRM Desktop is trying to contact, and then configure the firewall to allow 
the communication to succeed.

8.3.3 Sealed Documents Block Screen Captures
If you attempt to make a screen capture when a sealed document is on screen, the 
captured image often shows the sealed document in the foreground even though the 
sealed document is really in the background. This can mean that the application you 
were trying to capture is hidden. 

This is intended behavior that prevents sealed documents being captured through 
transparent foreground applications. See "Screen Capturing Sealed Documents" on 
page 4-9.

8.4 Formats
Sealed documents have file icons and extensions that are slightly different to their 
unsealed counterparts. The table below shows the icons and extensions for the 
supported types of sealed document. 

File icon Unsealed extension Sealed extension

pdf spdf

html | htm stml

png spng

gif sgif
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Formats
jpeg | jpg sjpg

doc sdoc

ppt sppt

xls sxls

dot sdot

xlt sxlt

pot spot

docm sdocm

dotx sdotx

dotm sdotm

File icon Unsealed extension Sealed extension
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Formats
pptx spptx

pptm spptm

potx spotx

potm spotm

xlsx sxlsx

xlsm sxlsm

xltx sxltx

xltm sxltm

mov smov

mpeg | mpg smp1

File icon Unsealed extension Sealed extension
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mp4 smp4

xml sxml

txt stxt

rtf srtf

csv scsv

doc seml

rtf seml

txt seml

File icon Unsealed extension Sealed extension
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Oracle IRM Desktop Options Dialog
AUser Interface

This section contains information about the user interface for Oracle IRM Desktop. The 
following features are described in this chapter:

■ "Oracle IRM Desktop Options Dialog" on page -1

■ "Sealed Email Options Dialog" on page -12

■ "Oracle IRM Desktop Sealed Document Information Dialog" on page -16

■ "General Features" on page -19

■ "Oracle IRM Desktop Toolbars" on page -28

A.1 Oracle IRM Desktop Options Dialog
The following tabs and dialogs are used to set options in Oracle IRM Desktop:

■ "General Tab" on page -1

■ "Desktop Sealing Tab" on page -2

■ "Servers Tab" on page -4

■ "Update Rights Tab" on page -5

■ "Search Tab" on page -6

■ "Email Tab" on page -7

■ "About Tab" on page -8

■ "Add Server Dialog" on page -9

■ "Search Log Configuration Dialog" on page -10

■ "Synchronization Log Configuration Dialog" on page -10

■ "Indexing Service Configuration Dialog" on page -11

Open the Oracle IRM Desktop Options dialog by right-clicking the Oracle IRM icon in 
the system tooltray and selecting Options, or by opening the Microsoft Windows 
Control Panel and double-clicking the Oracle IRM Desktop Options icon.

A.1.1 General Tab
Use for setting the main preferences.

Open by selecting the General tab on the Oracle IRM Desktop Options dialog.
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A.1.2 Desktop Sealing Tab
The desktop sealing feature integrates powerful sealing options into Windows 
Explorer:

■ Seal To, Reseal To and Unseal options are added to the File menu, and options to 
create new sealed documents are added to the New submenu. 

Oracle IRM information is added to the file properties available through Windows 
Explorer. If you select a file and open its Properties dialog, there is an Oracle IRM 
tab that shows, for example, which context the document is sealed to. 

A pop-up description is displayed when you move your mouse pointer over the 
name of a sealed document (if Windows Explorer is configured to show such 
pop-ups). 

Open by selecting the Desktop Sealing tab on the Oracle IRM Desktop Options dialog.

Element Description

Display Notification Area 
icon (checkbox)

Normally checked. Unless you are a Citrix user, uncheck to 
remove the Oracle IRM icon from the row of icons in the 
bottom right corner of the screen. When double-clicked, this 
icon opens the Oracle IRM Desktop options dialog. You can 
also open this dialog from the Windows Control Panel. Citrix 
users must not uncheck this box. 

Enable Microsoft Office 
support (checkbox)

Normally checked. Uncheck to disable the integration of 
sealing options directly into your Microsoft Office applications. 
Unchecking this option disables the opening of sealed 
Microsoft Office files. 

Display information bar 
(checkbox)

Normally checked. Uncheck to never show the Oracle IRM 
messages area in Microsoft Office documents. If checked, the 
information bar for a particular document can be closed by 
clicking the black cross on the right of the bar in that 
document.
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Element Description

Enable desktop sealing 
(checkbox)

Normally checked. Uncheck to disable desktop sealing.

Recently Used Contexts Max Entries: Default value is 5. Enter a number (between 0 
and 20) to specify how many recently used contexts are 
offered when you use the Seal To and Reseal To menu options. 
When you seal or reseal a file, you need to specify which 
context you want to seal to. The recently used context list 
makes it easier to complete this task. Use the Clear button to 
remove the current value. 
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Oracle IRM Desktop Toolbars
You can drag the Oracle IRM Desktop toolbar to a different location within the toolbar 
area, just as for any other toolbar in Microsoft Office.

Beneath the toolbar area in Microsoft Office is the Oracle IRM information bar (if the 
option to display it has been selected in the Oracle IRM Desktop Options dialog).

The information bar usually shows which context the document is sealed to.

A.5.3 Oracle IRM Desktop Toolbar in Microsoft Office 2007
The toolbar contains the following elements:

Element Definition

Control Panel (button) Used to open the Oracle IRM Desktop Control Panel.

Synchronization and Check 
In (button)

Use to open the the Update Rights tab on the Oracle IRM 
Desktop Options dialog. You can use this tab to update your 
rights from Oracle IRM Server, or to check in your rights so 
that they can be used from another device.

New Sealed (button) Use this button to create a new sealed document or a new 
sealed document from a sealed template.

Open Sealed (button) Use this button to open a dialog through which you can open 
existing sealed documents.

Save as Sealed (button) Use this button to create a sealed version of the current 
unsealed document.

Online Information (button) Use this button to go to a web page where the content 
originator will provide more information about your account, 
your licenses and the current content.

Element Definition

Control Panel (button) Used to open the Oracle IRM Desktop Control Panel.

Online Information (button) Use this button to go to a web page where the content 
originator will provide more information about your account, 
your licenses and the current content.

New Sealed (button) Use this button to create a new sealed document or a new 
sealed document from a sealed template.

Open Sealed (button) Use this button to open a dialog through which you can open 
existing sealed documents.

Synchronization and Check 
In (button)

Use to open the the Update Rights tab on the Oracle IRM 
Desktop Options dialog. You can use this tab to update your 
rights from Oracle IRM Server, or to check in your rights so 
that they can be used from another device.

Save as Sealed (button) Use this button to create a sealed version of the current 
unsealed document.
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